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QuickBooks 
For Conservation Districts 

 
This Introductory Manual was developed to use in conjunction with the QuickBooks 
Training for Conservation Districts.  It has been designed to cover the particular aspects of 
QuickBooks that have been adapted to conservation district accounting.  The manual is 
intended to be a supplement to the QuickBooks Startup and Quick Reference Guide 
(included with software purchase) and QuickBooks Help features K.J.S. Computer & 
Training Service LLC with the assistance of the State Conservation Commission updated 
the manual for distribution in Aug. 2015. The instructions are based on the QuickBooks 
Pro 2015 version.  Various reports and lists have been customized for conservation district 
use to meet statutory requirements.  The customized reports and lists are included in the 
Standard Conservation District Company File to be loaded with the QuickBooks software, 
which has already been done for most conservation districts.   
 
QuickBooks is a great accounting package for small businesses.  Even though you will not 
use all the features of QuickBooks, it will provide a professional accounting system for 
your conservation district. Your accounting skills need only be basic because QuickBooks 
does all the debits and credits behind the scenes for you. You will create claim vouchers, 
pay bills, receive payments, and make deposits – QuickBooks does the rest for you. You 
will also have the ability to do payroll and all the accounting procedures that come with 
running payroll if you choose to do so. 

 
 Starting QuickBooks for the First Time 
 
If you use an USDA computer/internet system, the IT Specialist will need to load the 
QuickBooks software and the Standard Conservation District Company File for you. 
 
 To launch QuickBooks: 
 

1. Click File 
2. Choose New Company. 
3. The following screen will appear. 
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For New Company, 
• Click on Express Start 

o Work through Wizard 
o Close Wizard 

 
 Restoring the Standard Conservation District 

Company File 
 
When QuickBooks opens, the window below will appear on your screen.  
 

 
 

1. You will select the applicable company 
2.  Click the Open button.  

 



 
  Page - 6                                           QuickBooks for Conservation Districts                  Introductory Manual 

 
 

3. Click the Restore a backup copy option. 
4. Click the Next button. 

 
 

 
 

5. Click the Local backup option.   
6. Click Next. 
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7. Double click on the Standard County Conservation District Company File 
8. Click Open. 

 

 
 

9. In most cases, you will save your company file to your hard drive. However, if you 
are working in a network environment, you will need to choose a location that can 
be accessed by all authorized users. 

10. At this point, you can also edit the File name so that it reads Standard County 
Conservation District, where Standard is the name of your county.   
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11. Click on the Save button. 

 
Once the restore process is complete, QuickBooks should open  the company file. If, 
however, you get a message indicating that the data is from a newer version of 
QuickBooks, you will need to click on ok to update. 
 
 
 

 
 

• If you are told you need to update your QuickBooks file you will need to type in 
“YES” and click on the OK button. 

• If you are restoring or opening a company file that has been password protected.  
You will need to enter a password for restore to work. 
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 Registering Your QuickBooks Software 
 
Once you have installed your QuickBooks software you will need to register your copy of 
the software with Intuit, the manufacturers of the QuickBooks series and software.  In 
order to do this, you will need to follow these steps: 
 

1. Go to the File menu and choose Register QuickBooks. 
 

 
 

2. Click on Begin Registration.. 

 
 

3. Enter your e-mail, or you can register by phone. 
4. Type in the registration number they give you.  When registration is complete you 

can print the license and product number in a safe place, in case you ever need to 
reinstall QuickBooks. 
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 Looking at the Screen 
 
You will notice that the QuickBooks screen is much the same as any other Windows 
application.  At the top of the screen you will see the file name you are currently using and 
to the right you will see the minimize screen, maximize screen, and close (exits 
QuickBooks) buttons.  Under the file name is the Menu bar. Under these is the title of the 
active window with the window close button.  The Navigation /Tool Icon Bar opens up on 
the side of your application. 
 
The Home page is displayed below.  It provides a clickable flow chart (click the icon for 
the task you want to do), shows account balances at a glance, and displays other features.     
 
When you open a window in QuickBooks, it appears in front of other windows that you 
previously opened.  The optional Open Window list keeps track of the windows that are 
open.  Use the Open Window list to switch between windows while you work   to show the 
Open Window List, from the View menu, choose Open Window List.  
 

 
 
QuickBooks provides several ways for you to perform a task by using the Menu bar, 
Navigation/Icon bar, or the Home page.  You choose the method that works best for you.     
 
As you use different windows in QuickBooks it is important to know that clicking the Next 
button will record the entry while keeping the window open so you can enter another 
transaction.  Clicking the Previous button will record the entry and display the previous 
entry in the form. The OK button will also record the entry but closes the window. Using 
the Cancel button will close the window without saving the current entry. 



 
  Page - 11                                           QuickBooks for Conservation Districts                  Introductory Manual 

 Working with Centers 
 
QuickBooks now puts all your critical business information in easy-to-read, easy-to-access 
centers. You can quickly analyze the information to make smarter and faster business 
decisions.  You can go to one of the centers by clicking the appropriate button in the Icon 
bar (on the left side of the toolbar). 
 

• The Customer Center focuses on customers, telling you what they owe, how to 
contact them, and more. A customer is any one that gives you money. 

• The Vendor Center focuses on vendors, telling you what you owe, how to 
contact them, and more. Vendors are any one you pay money to. 

• The Employee Center is used to manage payroll for those who are signed up for a 
QuickBooks Payroll Service (fee required), but anyone may use it to record 
employee contact information.  

 

  QuickBooks Help Features 
 
QuickBooks makes it very easy to get help. You can go to the Help menu and click 
QuickBooks Help or press F1 to bring forth the Help window.  You can use the Index tab 
to find topics for a specific term or concept or use the Search tab to ask a question. 
 
The How Do I feature is located on every window in the program and will give help 
related just to that particular window and activity.  Simply click the How Do I button and 
choose the topic which best meets your need for help. 
 
Another help feature is the QuickBooks Learning Center.  It offers short tutorials covering 
QuickBooks basics.  When you begin using QuickBooks it will be one of the first things 
you’ll see.  To open later, go to the Help menu and click Learning Center Tutorials.  
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 QuickBooks Updates 
 
Intuit provides updates to QuickBooks periodically that can be downloaded from the 
internet.  QuickBooks is initially setup to automatically download updates.  For those of 
you using an USDA internet connection, the IT Specialist may need to perform this 
manually.  Please check with the IT Specialist to see if the QuickBooks updates can be 
manually downloaded by you or if he/she must periodically download the updates for 
you.  

 
 Customizing the Standard Conservation District 

Company File 
 
Okay, you have installed and registered the software and successfully restored the Standard 
Conservation District Company file.  Now it is time to CUSTOMIZE. 
 
Let’s start by putting in the conservation district name, address, etc. To do this, follow 
these steps: 
 

1. Go to the Company menu and choose  My Company.
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2. Replace the XXX County Conservation District with the name of your conservation 
district. 

3. Fill in your Address – City – State – Zip. 
4. Fill in your Phone and Fax numbers. 
5. Fill in your Federal Employer Identification Number (this is required if you use the 

QuickBooks Payroll Service). 
6. When all fields are completed, click the OK button. 

 
 Editing the Preferences 
 
Preferences are settings that can be set for your company file (Company Preferences) as 
well as preferences that only affect your computer (Personal Preferences). 
 

1. To review the preferences, go to the Edit menu, and click Preferences. 
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2. When the Preferences window opens you will notice that there are two “tabs” in 
the Preferences window:  My Preferences and Company Preferences.  Items 
listed under My Preferences affect only your workstation and are designed to 
customize the software to the user.  Whereas, Company Preferences affect all 
users of the QuickBooks file. Most of the Company Preferences have already 
been set for you. 

 
 

Let’s practice changing one of the personal preferences. 
 

1. Click General in the list on the left in the Preferences window. 
2. Make sure the My Preferences tab is active. 
3. Click the blank checkbox next to “Pressing Enter moves between fields.” 
4. Click the OK button to save the changes. 
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 Collecting Sales Tax 
 
If your district collects Sales Tax you will need to set that up in the Company 
Preferences. 

 
1. Go to the Edit menu click Preferences. 
2. Click Sales Tax in the list on the left in the Preferences window. 
3. Click the Company Preferences tab at the top. 
4. Select Yes to “Do you charge sales tax?” 
5. Click the Add sales tax item button.  Sale Tax Items are used to calculate and add 

sales tax charges when you make a taxable sale. 
 

 
 

6. From the drop-down list click Sales Tax Item.  

 
7. Enter Sales Tax in the Sales Tax Name field. 
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8. “Sales Tax” will default in the Description field, which is fine.  This is what will 
appear as a line item on your sales form. 

9. Enter the applicable sales tax rate. 
10. Select the Tax Agency from the drop-down Vendor List.  If not listed, select Add 

New and complete the agency information in the New Vendor window.   
11. Click OK to close the New Vendor window. 
 

 
 
12. Click OK to close the New Item window. 
13. QuickBooks creates two sales tax codes and these should be all you’ll need to use. 
14. Select the sales tax item you want to use from the Your most common sales tax 

item drop-down list. 
15. Select Upon receipt of payment under “When do you owe sales tax?” 
16. Choose the applicable response under “When do you pay sales tax?” 
17. Click OK. 
18. If you have already set up your items and customers, you’ll be prompted to assign a 

taxable sales tax code.  Click OK if most are taxable, if not, clear the checkboxes 
and click OK.  (At any time you can edit items and customers to change the Tax 
Code when needed.)  

 
When the sales tax function is turned on, QuickBooks will create a new account, possibly 
2000, “Sales Tax Payable”.  Every time sales tax is charged when using a sales receipt or 
invoice, the sales tax will increase the balance in this account. Then when the district pays 
sales tax from the Vendor Navigator, the payment will reduce the balance in this account. 
The account’s main purpose is to keep track of sales tax charged and paid in to the Kansas 
Department of Revenue. 

 
 Entering Opening Balances 
 
We recommend entering beginning balances after receiving the bank statement(s). 
Section A of the following will apply to most Districts. 
 
At this point you need to make some decisions. 
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Question #1: What do your financial statements currently show in terms of assets and 
liabilities? Do you have any assets other than cash? Any liabilities? Receivables? 
Inventory? 
 
Question #2: Will you be running QUICKBOOKS parallel to your current accounting 
system? 
 
Question #3: Assuming that you have no assets other than cash and no liabilities, do you 
want your year-to-date balances to match or do you merely want to compare monthly 
activity? 
 
Section A: In the event that you only have cash, you will be running parallel to your 

current accounting system and the year-to-date balances do not need to 
match, you can use these simple procedures. 

 
1. Make a Journal Entry to record the beginning balances in each cash account 

(Banking>Make Journal Entry.) 
a. The entry should be dated one day prior to your start date. So if you choose 

December 1st for your start date, the journal entry should be dated November 
30. 

b. Debit each cash account for the bank balance (not the reconciled book balance). 
If a cash account has as a negative bank balance, you should credit the account, 
rather than debt it. 

c. After you have entered a balance for each cash account, you should have a 
remaining balance (probably a credit), code this balance to account #3900 
Retained Earnings. 

2. Enter Outstanding Checks and Outstanding Deposits. 
a. Use the Write Checks and Make Deposits options to key each outstanding 

check and outstanding deposit. 
b. You may use the original dates of the transactions or simply date them the same 

as your journal entry from step 1 (above). 
 

Section B: If you only have cash, but you want your year-to-date balances to match. 
 

1. Complete Step 1 from Section A. 
2. Complete Step 2 from Section A, but code the checks and deposits to account 

#3900 Retained Earnings. 
3. Make a Journal Entry to key year-to-date income and expenses. 

a. Again, date the entry one-day prior to your Start Date. 
b. Each line on the journal entry will represent a year-to-date balance in either an 

income or an expense account. Generally income accounts carry a credit 
balance and, therefore, you will enter those balances in the credit column. 
Similarly, expenses generally carry a debit balance, so you will enter those 
balances in the debit column. 

c. When you have finished, the remaining balance should equal your net income 
or loss for the year. Code this amount to account #3900 Retained Earnings. 

 
Section C:  If you have assets and liabilities other than cash, including inventory. 
 

1. Complete Step 1 from Section A, but expand the journal entry to include line items 
for each asset and liability account, except accounts receivable, accounts payable, 
and inventory. 

2. Complete Steps 2 and 3 from Section B. 
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3. Use Invoice and Bill options to enter outstanding receivables and payables. 
a. Create an Item for Beginning Balances and have it “point to” account #3900 

Retained Earnings. 
b. Use the Item created in 4a to enter an Invoice or Bill for each outstanding 

receivable and payable. 
4. Enter beginning inventory balances through an inventory adjustment. 

a. Refer to the QUICKBOOKS help menu for additional instruction on adjusting 
inventory. 

b. Adjust the Quantity and Value of each item in inventory.  (Most will not use.) 
c. Date the adjustment one day prior to the Start Date. 
d. The Adjustment Account should be account #3900 Retained Earnings. 

 Data Entry Quick Tips 
 
Now that we have set up your “company,” let’s learn some quick ways to get around in 
QuickBooks. After we review these quick tips you can continue and add some accounts, 
items, customers and vendors.  Once these are added to our company we can then learn 
how to generate the reports we need for the conservation district. 

 
 

EFFECT YOU WANT 
 TO ACCOMPLISH SHORT KEY 

To increase a date or form number + 

To decrease a date or form number - 
To change date to the end of the year R  (yeaR) 
To change date to the beginning of the 
year 

Y (Year) 

To change date to end of the month H (montH) 
To change date to beginning of the month M (Month) 
To change date to today's date T 
To move to the next field Tab 
To move to the previous field Shift + Tab 
To cancel a transaction or close a window Esc 
To undo changes made to a field Ctrl + Z 
To move to line above in detail area Up Arrow 
To move to line below in detail area Down Arrow 

 
 
You also always have a built in calculator if you are in an amount field, all you need to do 
is type in the first number and then hit the + (for Addition) – (for Subtraction) / (for 
Division) or * (for Multiplication).  Just continue with all the numbers and then press Enter 
for =.   
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 QuickBooks Lists 
 
QuickBooks lists organize a wide variety of information and it is this information that is 
used to fill out the forms and reports.  The primary lists that conservation districts use are 
the Chart of Accounts, Items List, Class List, Customer & Job List, Vendor List, and 
Employee List (primarily for those with a payroll subscription). 
 

 Types of Accounts 
 
There are two main types of accounts in the QuickBooks Chart of Accounts:  Balance 
Sheet Accounts and Income and Expense Accounts. 
 
Balance Sheet Accounts 
QuickBooks provides nine types of balance sheet accounts to choose from as you create 
and add to your Chart of Accounts. The following table describes each type of balance 
sheet account and the transactions you can use it for. 
Type of Account Transactions you can use it for 
Bank Checking, savings, and money market accounts. Add one 

bank account for every account your company has at a 
bank or other financial institution. Conservation District 
use this type for petty cash. 

Accounts receivable (A/R) Transactions related to the customers that owe you 
money, including invoices, payments, deposits of 
payments, refunds, credit memos, and statements. Most 
companies have only one A/R account. 

Other current asset 
(Not Included in Sample 
Chart of Accounts) 

Assets that are likely to be converted to cash or used up 
within one year notes receivable due within a year, 
prepaid expenses, and security deposits. 

Fixed asset 
(Not Included in Sample 
Chart of Accounts) 

Depreciable assets your company owns that aren’t likely 
to be converted into cash within a year, such as equipment 
or furniture. 

Other asset 
(Not Included in Sample 
Chart of Accounts) 

Any asset that is neither a current asset nor a fixed asset, 
such as long-term notes receivable.  

Accounts payable (A/P) Transactions related to money you owe, including 
bills, bill payments, and any credit you have with vendors. 
See also current and long-term liability accounts. 

Credit Card- 
Not Debit Card 

Credit card purchases, bills, and payments. 

Current liability Liabilities that are scheduled to be paid within one year, 
such as sales tax, payroll taxes, accrued or deferred 
salaries, and short-term loans. 

Long-term Liability 
(Not included in Sample 
Chart of Accounts) 

Liabilities such as loans or mortgages scheduled to be paid 
over periods longer than one year. 

Equity Owner’s equity, including capital investment, drawings, 
and retained earnings. 
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Income & Expense Accounts 
 
Type of Account Used to track 
Income The main source of money coming into your company. 
Other income Money received for something other than normal business 

operations, such as interest income. 
Expense Money that’s leaving your company. 
Other expense Money spent on something other than normal business 

operations, such as corporate taxes. 
Cost of Goods sold The cost of goods and materials held in inventory and then 

sold. 

 
 Working With Your Chart of Accounts 
 
The Chart of Accounts is a complete list of your business accounts and their balances.  The 
Standard Company File has a wide range of accounts currently used by districts across the 
State using the standard account numbers.  It is not intended to be comprehensive, but 
should include a majority of the general ledger accounts that you will need. You may add 
or delete accounts as necessary.  However, we recommend that you do not delete any for a 
few months until you have worked with it for a while. That way, you can be sure whether 
or not you need the accounts. 
 
The Chart of Accounts, a copy of which is located in the Appendix, has been organized in 
a series of “header” accounts and “subaccounts”.  Each header account is designed to be a 
line item on the conservation district’s year-end Statement of Cash Receipts and Cash 
Disbursements.  Please keep this in mind when you are making changes to the Chart of 
Accounts. 
 
Account numbers are used to provide a method for classifying accounts.  They are also 
used as a unique identifier to each account so there is no confusion if there are similar 
accounts in two different sections of the financial section.  Account numbers may be 
turned off in the Preferences, however we recommend using them. 
 
When creating a subaccount you must create two subaccounts. You will no longer code 
transactions to the main account.  Instead, you will code transactions to the subaccounts. 
The theory is that you are “splitting” the account, and therefore, you will have at least 
two subaccounts. 

 
 Editing Bank Accounts 
 
There are two methods to choose from when setting up the checking and saving bank 
accounts in the Chart of Accounts. The method that you choose will be determined by the 
district’s current accounting procedures. 
 
If two or more funds are tracked within one bank account, you will use the Multiple Fund 
Method.  On the other hand, if each fund has its own bank account, you will use the Single 
Fund Method. 
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The Multiple Fund Method is illustrated using Checking Account #1 and Checking 
Account #2 above. This method uses a “header account” or “title account”.  A header or 
title account is an account to which no transactions will be posted. Rather, the transactions 
will be posted to the “subaccounts,” which will represent each of the district’s funds.  At 
the end of the banking cycle, when the account is reconciled, it is the header account that 
will be reconciled.  The header account combines the registers of each of the subaccounts, 
allowing you to reconcile the entire bank account at once rather than trying to reconcile 
each fund separately. 
 
The Single Fund Method is illustrated in the Checking Account #3 and Checking Account 
#4. This method is best suited to those districts that have a separate bank account for each 
fund. 
 
Given QuickBooks ability to keep subaccount registers; you may want to consider 
changing to the Multiple Fund Method, particularly if you are incurring bank service 
charges on each of your checking accounts. The Multiple Fund Method will also cut 
down on administrative time to reconcile the account since you will only need to 
reconcile one account. 
 
Tip- You can order different colored checks or use a different check numbering sequence 
for each of the sub-accounts. This allows you to differentiate between the funds without 
needing separate checking accounts. 

 
Both of these methods were setup in the customized file for conservation districts.  The 
Chart of Accounts must be edited to reflect your district’s bank accounts. 
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In order to do this, follow these steps: 
 

1. Go to the Icon menu and click the Chart of Accounts icon (if icon has not been 
created, go to List menu and click Chart of Accounts). 

2. Click on the line of the bank account that you want to edit. 
3. Click the Account button (bottom of screen) and then click Edit Account. 

 

 
 

4. Modify the Account Name, enter the Bank Acct. No. 
5. Click Save & Close.  
6. Repeat steps 2-5 for each applicable bank account. 

• If your district has one checking account to manage two funds:   
 Edit the bank account with the number 1000 by entering the name of the 

bank (i.e. 1st State Bank) in the Account Name field.  
 Edit 1001 to read “Operations Fund, Checking” and 1002 as the “Enterprise 

Fund, Checking” or similar wording.  
 

• If your district has one checking account to manage two funds and sub-funds:  
 Edit the bank account with the number 1005 by entering the name of bank 

(i.e. 1st State Bank) in the Account Name field. 
 Edit 1006 to read “Operations Fund Checking” with 1006.1 as “Operations” 

and 1006.2 can be “NPS” (or whatever).  
 Edit 1007 to read “Enterprise Fund Checking” with 1007.1 as “Enterprise” 

and 1007.2 be assigned a name to track grant money, for example. 
 

• If your district has separate checking accounts to manage the Operations and 
Enterprise Funds: 
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 Edit the bank account with the number 1010 by entering the name of bank 
with the fund type (i.e., 1st State Bank-Operations Fund) in the Account 
Name field.  There are a limited number of character spaces, so you may 
need to abbreviate. 
 Edit the bank account with the number 1015 by entering the name of bank 

with the fund type (i.e., Bank of America-Enterprise Fund) in the Account 
Name field.   

 
Each savings account and Certificates of Deposit can be set up and reconciled in the same 
manner.  These should not be set up as subaccounts if they have their own bank account 
number. 
 
Even though Petty Cash is a sub-fund of the Operations Fund and/or Enterprise Fund, for 
reconciliation purposes it would be easier to set this up as a Header Account in your Chart 
of Accounts. 
 
For the account name be sure to identify the type of fund, i.e. Operations, or Enterprise.   
 
Tip- For Certificates of Deposits you can include the maturity date in account name, i.e. 
“Ent Fund CD, matures 12/01/2009.”  
 
Tip- If savings accounts are set up at more than one bank, the bank name could be 
included, i.e., “1st State Bank, Ent CD 12/15/15.”  There are a limited number of 
character spaces, so you may need to abbreviate. 

 
 
Since transferring of funds must be approved by the board, avoid using the Transfer 
Funds feature. This will accomplish a transfer of dollars from one bank account to the 
next, but the transfers will not be reflected for approval on the Unpaid Bills Needing 
Board Approval Report.  To record these transactions, write a “check” from one fund and 
code it to Account #6600 Transfers to Other Funds (expense). There is no need to assign 
a check number when you are not writing a check. If you wish, you can key “XFER” into 
the check number field to designate that transaction as a funds transfer. Then, make a 
“deposit” into the recipient fund and code it to Account #4080 Transfers from Other 
Funds (income).   
 
 Income and Expense Accounts 
 
The income and expense accounts in the Chart of Accounts track the sources of your 
income and the purpose of each expense.  When you record transactions in one of your 
balance sheet accounts, you usually assign the amount of the transaction to one or more 
income or expense accounts.  For example, not only do you record that you took money 
out of your checking account, but you keep track of what you spent the money on, such as 
utilities or office supplies. 
 
You can edit the income and expense accounts by following the instructions previously 
provided on editing the bank accounts.  Before you get too carried away on deleting any, 
you may want to use the “Hide Inactive Accounts” option located in the Account drop-
down menu for a while. 
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QuickBooks does not display balances for income and expense accounts in the Chart of 
Accounts. One way to see these balances is by choosing Company & Financial from the 
Reports menu and then click one of the Profit & Loss report options. You can also click 
on the income or expense account in the Chart of Accounts, right click, and choose Quick 
Report from the menu. 
 
You may want to add subaccounts to your 6000 Cost of Goods Sold Account to track items 
that you are selling.  Use this Cost of Goods Sold Account when you are not tracking 
inventory in QuickBooks.  (If tracking inventory in QuickBooks, use Chart Account 
number 5000 *Cost of Goods sold.)   
 
Let’s say you want to add a subaccount to track Marking Flags.  In order to do this, follow 
these steps: 
 

1. Go to the Icon menu and click the Chart of Accounts icon. 
2. Click the Account button (bottom of screen) and then click New. 
3. Choose Other Account Types, select Cost of Goods Sold, and then click 

Continue. 
 

 
 
4. Enter 6005 in the Number field. 
5. For the Name use Marking Flags Expense. 
6. Select the Subaccount of checkbox. 
7. From the drop-down list, click 6000 Cost of Goods Sold. 
8. Click Save & Close. 
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 Adding an Account to the Chart of Accounts 
 

1. Go to the Icon menu and click the Chart of Accounts icon.  
 

 
 

2. Click the Account button (bottom of screen) and then click New. 
3. Choose the type of account you wish to add and then click Continue. 
4. Fill in the window as needed. 
5. Click Save As or Save & New to add another account. 

 

For products you buy and resale, an account will need to be set up for when you 
purchase the product as an expense and when you sell the product as an income.   
 
Tip- For easy recognition of an expense account vs. an income account you can 
name the expense (Grass Seed Expense) distinguishable from the income (Grass 
Seed Income). 

 
 Adding Additional Bank Accounts 

 
If you have been using QuickBooks and have decided that you need to setup another bank 
account you will just add this account like you did the Chart of Accounts earlier.  If you 
are transferring money from another account into the Bank account, you will need to write 
a check from that account and make a deposit into this new Bank account. 
 
If the bank account is being setup based on grant money you will just setup the new bank 
account just like the other chart of accounts you added before and then add the opening 
balance at the time you setup the account. You will not be able to go back and add the 
opening balance so be sure to add it as you set up the account. 
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 Items and Their Use 
 

QuickBooks uses Items to prepare Claim Voucher (Purchase Orders), Cash Sales Receipts, 
and Invoices; in fact, any item on a Claim Voucher, Sales Receipt or Invoice must be 
entered into an Item List first.  An item is anything that your company buys, sells, or 
resells.  Items are your products, services, and things such as postage, discounts, and sales 
tax.  When you create an item you link it to an account in the Chart of Accounts. 
 
The following is a table listing QuickBooks Item Types, Description of those items, and 
When to Use the items. 
 

Item Type Description When to Use 
Service Services rendered to or 

received from others. 
If you buy or sell these 
services. 

Inventory part Inventory parts you 
purchase, track as 
inventory, and then sell. 

If you want to track these 
items in terms of value, 
quantity, and/or the number 
you have on order. 

Non-inventory Part Inventory Parts that you do 
not want to track in terms of 
quantity. 

If you do not track the 
quantity. 

Other Charge Miscellaneous charges. This could be freight, 
handling charges, or 
delivery charges that you 
will include on invoices. 

Subtotal Calculates subtotals. Adds totals before any 
discounts or sales tax are 
added. 

Group Allows a group of 
individual items to be added 
quickly. 

Items grouped together such 
as Subtotal and Sales Tax. 
This can also be individual 
items  

Discount Calculates the amount that 
is to be subtracted from 
either the total or the 
subtotal. 

If items receive or give 
discounts off the selling 
price. 

Payment Reduces invoice total. Use when paying or 
receiving money before the 
invoice or purchase order is 
prepared. 

Sales Tax Item Calculates a single sales 
tax. 

Use this for sales tax 
charged to customers. 

Sales Tax Group Calculates two or more 
sales taxes grouped on the 
same sale. 

Use if a combination of 
sales tax rates is required as 
a one line item on an 
invoice. 
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 Adding an Item to the Item List 
 
1. Go to the List menu, Click Item List or click on the Item icon.  You will then be at 

your Item List. Once again it looks and acts much like the other lists that you have 
been working with. 

 

 
 
2. Click on the Item button and choose New to add items.  
3. Once you have added an item you can click Next to record the entry and add the 

next item.  
4. Click OK to record the entry and close the New Item window.  

 

Tip- For easy recognition of an expense item vs. an income item you can name the 
expense (Grass Seed Expense) distinguishable from the income (Grass Seed Income). 

 
All items do not need to be setup as you begin to use QuickBooks. You can also add items 
on an as needed basis (for example, when you are entering a claim voucher or a sales 
receipt.)  
 

In order to use the Sales Tax section of QuickBooks, you need to be sure the 
Company Preference for Sales Tax is turned on in the Preference Menu. 
 
In order to use the inventory section of QuickBooks, you need to be sure the 
Preference for Tracking Inventory is set to YES.  Most conservation districts do 
not need to track inventory in QuickBooks. 
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If your item list is alphabetized in two separate lists that is because they are listed and 
alphabetized by Type. You cannot change the type of any item except Other Charge. You 
can change Other Charge items to Service types if you want them all alphabetized in one 
list. You will not be able to change them back once the change has been made. 
 
You cannot delete any item if it has been used in a transaction.  If you do need it deleted, 
run a QuickReport on that item and change all transactions that it was associated with. 
 
To print your “Item List,” go to the Lists menu and click Item List, then click File menu 
and Print List.  A sample Item List is in the Appendix. 

 
 Class Lists 
 
By using Class Lists this will let you organize funds by classes or in this case by Funds. 
The Class List should be comprised of the funds that are used in the district. The Standard 
Conservation District file includes an Operations Fund and an Enterprise Fund. You will 
note that each of these funds is broken down further into “sub-funds”.  Basically, the main 
funds are made up of smaller funds. Using this methodology, transactions will only be 
coded to the sub-funds. The balance in the main fund will be the total of all the balances in 
the sub-funds. 
 
To view the Class List, go to the Lists menu and choose Class List. 
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 Adding Customers 
 
To begin let’s add a customer to our company. 
 

1. Click on the Customer Center located on the Navigator bar.  This will take you to 
a Customers & Jobs List Window.  At this time you will not see many but we will 
add more now. 

2. Click the New Customer & Job button and choose New Customer from the sub-
menu. 
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3. Add the following charge customer with their information on the appropriate 
tabbed pages.  All customers are taxable unless they are otherwise noted. 

 
Customer: City of Hays 
Opening Balance: 0 
As of: 09/17/2015 
 
On the Address Info Tab type the following: 
 
Company Name: City of Hays 
Mr./Ms./.. Ms. 
First Name: Stephanie 
Last Name: Little  
Address: PO Box 898 
 Hays, KS 67601 
Contact: Stephanie Little 
Phone: 785-625-4455 
Fax: 785-625-4451 
Ship to: Click the Copy button. 
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On the Additional Info tab type the following: 
 

Type: Business (choose to Quick Add) 
Representative: (Leave Blank) 
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On the Payment  
Setting  tab type the following: 

 
Account: 12-1234 
Credit Limit: $5,000 
Payment Terms  Net 30 
Preferred Payment Method: Check 

 

 
 

4. Click OK to record this customer. 
 
When you are first setting up QuickBooks you will need to be sure to add any customers 
that have an opening balance as of your start date. 
 
If the customer is paying cash/check, you will not need to set them up. However, if they 
are a recurring customer, it would be best to set them up and enter the Opening Balance as 
zero.  Address information is optional and no need to add the other non-applicable 
information.   
 
A customer can be added when entering a sales receipt or invoice by clicking on Add New 
in the Customer:Job drop-down list. 
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 Notes for Customers 
 
As you have been setting up your customers, you may have noticed an Edit Notes 
button over on the right side of your window. This is so that you can add notes on your 
customers. When you add a note to a customer, you will see a note icon next to their 
name in the list of customers. This is handy when there might be special arrangements 
to be made with a customer. 
 

 
 
 Editing an Existing Customer 

 
There are times when you are working with QuickBooks that you will need to edit your 
customer’s information. For example, they have a change of address or contact person. 
 

1. From the Customer list, click Edit (or simply double click the customer to 
edit). 

2. Make any changes that are needed. 
3. Click on the OK button. 
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 Entering Sales Receipts – Cash Customers 
 
If you are selling to a customer and they are paying for it that day, you will enter it as a 
sales receipt.  A receipt should be created for all money received by the district except 
payment received for an existing QuickBooks invoice. 
 

Tip– In order to speed up your process of a computer generated Sales Receipt; you 
can open the sales receipt window on your computer and just minimize it so it is 
always ready for use. 

 
To create a Sales Receipts: 
 

1. Go to the Customers menu and click Enter Sales Receipts.   
 

 
 
2. Enter or choose the customer from the Customer:Job drop-down list.  If your 

customer is not listed, choose Add New and complete the Customer Name.  You 
may wish to complete some of the other information. 

3. Click in the Item column, and select the Item from the drop-down list (what the 
customer purchased), then complete the Description, the Quantity (if applicable), 
the Rate (if applicable), the Class, the Amount if the Rate was not completed, and 
Tax (if you have the sales tax options setup.  (When you fill in the Sales Receipt 
the money goes to the income account from the Chart of Accounts you chose when 
setting up the Item.) 
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4. Fill in check number and payment method. 
5. Complete the Memo field (lower right side of screen). 
6. Make sure funds are going to appropriate bank account in the Deposit to window. 
7. Click Print on the toolbar to print the invoice now.  You can change the number of 

copies to 2 so there is one for the customer and one for you. 
8. Click Save & Close after printing. 

 

When you receive payments from customers, you can either deposit each payment 
directly into a QuickBooks bank account like we just illustrated, or you can group 
payments together to be moved to that account later by using the Undeposited Funds as 
the default Deposit To account.  If you choose this option, QuickBooks holds the payment 
in another current asset account called Undeposited Funds until you make a deposit (in 
QuickBooks- using the Make Deposits window and the bank).  The latter option may 
reflect the bank deposit slip/bank statement to make it easier for you to reconcile your 
bank accounts.  To set this Sales & Customers Preference, select Company Preferences 
tab and then click the blank checkbox next to User Undeposited Funds as a default deposit 
to account.  If you use this option you will have to print a Deposit Detail report to go 
along with your Treasurer’s Reports.  Note:  The Deposit To drop-down list will not be 
displayed on the Sales Receipt. 

 
 
Reminder – Always fill in the Memo field because this is what prints on your reports. 
 
 

If using Sales Receipts outside of QuickBooks (manually), there is no need to create a 
Sales Receipt in QuickBooks. Instead you will need to go to the Banking, click on the 
Make Deposits, and enter your sales and other deposit information. You will need 
complete this process for each bank account.  Be sure to enter your receipt number in the 
Memo field so it coincides with your hard copy receipt. 
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 Creating Invoices – Charge Customers 
 
Once you have setup your Customers and setup your Items you can now start Creating 
Invoices. You will only use Invoices when you are wanting to BILL or CHARGE a 
customer.  If they are paying cash/check, you will use a Sales Receipt. 
 
To create an Invoice: 
 

1. Go to the Customers menu and click Create Invoices. 
2. Enter or choose the customer from the Customer:Job drop-down list.  If your 

customer is not listed, choose Add New and complete applicable information. 
 

 
 

3. Click in the Item column, and select the Item from the drop-down list, then 
complete the Quantity (if applicable), the Description, the Rate (if applicable), 
the Class, and the Amount if the Rate was not completed. 

4. Complete the Memo field (lower right side of screen). 
5. Click Print on the toolbar to print the invoice now or select the To be printed 

checkbox to print later.   
6. Click Save & Close if done creating invoices or Save & New to create another 

invoice. 
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 Creating Statements  
 
At the end of each month or whenever you choose to print these, you can print statements. 
This will give your customers the balance forward from the last month and the additional 
charges, if any, for this month.  All unpaid invoices for the current period would be listed.  
 
To create Statements: 
 

1. Go to the Customers menu and click Create Statements. 
 

 
 

2. If a choice of account is displayed, choose the A/R account for the statements you 
want to print. 

3. The Statement Date will be today’s date.  If you change the date, you are also 
changing the date due for statement charges. 

4. Choose to create statements for transactions within the Statement Period fields. 
You have the option to create statements for all open transactions as of the 
statement date. 

5. Select Customers for whom you want to print statements, normally All Customers. 
6. Under “Do not create statements:” click the blank checkbox with a zero balance. 
7. If applicable, click Assess Finance Charges to add finance charges to the 

statements. 
8. Click Preview to review the information that will appear on the statements. 
9. If they look okay, click Print to print your statements. 
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 Receiving Payments for an Existing Invoice 
 
To record a payment you’ve received for an invoice follow these steps: 
 

1. Go to Customer menu and click Receive Payments. 
2. Select the customer from the Received From drop-down list.  The date and amount 

of all open invoices for this customer will appear.  
 

 
 

3. In the Amount field, enter the payment amount.  
4. In the Date field, today’s date appears, but you can enter a different date if 

necessary. 
5. From the Pmt. Method drop-down list select the method the customer used to pay 

this invoice. 
6. In the Check # field, if the customer paid by check, enter the number. 
7. Complete the Memo field.  This is what will show up on the reports. 
8. Make sure funds are going to appropriate bank account in the Deposit to window. 
9. You will notice the check mark in front of the invoice it is going to apply to. 
10. Click Save & Close to record the payment. 

 
If you use the Undeposited Funds option, you will need to make a Deposit in QuickBooks 
and empty the Undepostied Funds Account.  
 
Reminder – Always fill in the Memo field because this is what prints on your reports. 
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 Creating a Claim Voucher 
 
Claim Vouchers are an essential element in the internal control system of the conservation 
district.  Printed Claim Vouchers (with supporting documents) are reviewed by the 
Treasurer and certified as being a valid claim.  In the customized version of QuickBooks 
for Conservation Districts, the Purchase Order template was modified to a Claim Voucher.  
The data used to create the Unpaid Bills Needing Board Approval Report comes from the 
Claim Vouchers.    
 
To create a Claim Voucher: 
 

1. Either click on Claim Voucher in the Icon bar or choose Purchase Orders from 
the Vendors menu.  (If the claim voucher template does not appear, go to 
Customizing the Purchase Order to a Claim Voucher discussed later in the manual.) 

 

 
 

2. Complete the following: 
• Vendor:  Either use the pull-down menu to choose an existing vendor or 

Add New to add a new vendor.  The Vendor is the company, individual, or 
organization to whom a check will be written.  If you are paying an 
employee mileage or expense reimbursements, you will need to set them up 
as a Vendor. Use a middle initial or something that is different than how 
they are set up in the employee list (for payroll purposes). 

 
• Class:  Use the drop-down menu to choose the appropriate fund.  The entry 

in this field should match the entry in “Fund,” which is discussed later.  
 

• Date:  You should enter the date the check will be issued.  In most cases, 
this will be the date of the District’s board meeting. 

 

• Claim Voucher #: The Claim Voucher # will increase incrementally each 
time a Claim Voucher is entered into QuickBooks.  Input in this field will 
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only be necessary if you want to override the number that QuickBooks 
assigns.  You can enter the check number if not using computer 
generated checks. 

 

• Due Date:  Should match the Date field and should be the same as the 
check date. 

 

• Item:  Use the pull-down menu to choose the appropriate Item. In this case, 
it is the Utilities – G&E item that was created earlier. 

 

• Description:  If you wish, you can change or add to the description. You 
will recall that we entered a description when the Item was created. That 
description now shows up on the Claim Voucher. 

 

• Quantity:  The quantity field is not necessary unless you are purchasing a 
quantity of inventory items that will be tracked in QuickBooks. 

 

• Rate:  Enter the amount of the expenditure associated with this line item, if 
applicable or just complete the Amount field. 

 

• Fund: Use pull-down menu to choose the appropriate fund. In this case, we 
have chosen the Operations Fund. 

 

• Amount:  QuickBooks will calculate based on input in the Quantity and 
Rate fields, if applicable or you can enter the total. 

3. To be Printed: If you wish to print several Claim Vouchers in a batch, make sure 
this box is checked. You will then be able to print all the Claim Vouchers at one 
time by going to the File menu, choose Print Forms, and then choose Purchase 
Orders. On the other hand, if you prefer to print the Claim Vouchers one at a time, 
simply click on the print button at the top of the screen before saving the claim 
voucher. 

 

Tip- It may be easiest to print your Claim Vouchers in a batch prior to the District’s 
board meeting.  That way you can immediately follow up by printing the Unpaid Bills 
Needing Board Approval Report. 

 
4. Memo: Enter a short description of the expenditure.  
5. Click on Save & Close to save the transaction and close the Claim Voucher 

window or click on Save & New to save the current Claim Voucher and enter 
another. 

 
Reminder – Always fill in the Memo field because this is what prints on your reports. 
 
Do not convert any Claim Vouchers into bills until after you print the Unpaid Bills 
Needing Board Approval Report (see instructions on “Preparing the Treasurer’s Report”).  
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 Payroll and Payroll Taxes (Not Using QuickBooks 
Payroll Features) 

 
You will need to create Items to use for payroll, payroll taxes, and other payroll related 
payments.  Please refer to the previous instructions on Adding an Item to the Item List.  
Examples of items for Payroll and Payroll Taxes are pictured below. 
 

 
 
The Chart of Account numbers 6050 through 6064 are used when doing payroll without 
the QuickBooks payroll service subscription. 
 
If you have KPERS you will need to add account number 6053 KPERS – Employee 
Contribution as a subaccount of 6050 – Salaries and Wages. Add account number 6065 
KPERS – Employer Contribution as a subaccount of 6060 – Employee Benefits. 
 

There is a subscription charge to use the Payroll Feature in QuickBooks.  The 
instructions are not included in this manual.  Please refer to the Startup and Quick 
Reference Guide that was included with your QuickBooks software purchase or other 
information provided by Intuit. 
 
Account numbers 2100 through 2145 are set up to be used in the QuickBooks Basic 
Payroll (subscription required). 
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 Preparing a Payroll Claim Voucher 
 
If you are not using QuickBooks to process payroll and are instead keeping external 
payroll records, you need to prepare separate claim vouchers for each check to be issued. 
In that case, you would have a separate claim voucher for each employee paycheck and tax 
remittance.  The reason for this is that it will simplify the process of converting claim 
vouchers into bills, which is discussed later in the manual.   
 
Here is an example of how a Payroll Claim Voucher may be completed: 
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 Converting Claim Vouchers into Bills for                         
Payment 

 
Did you print the Unpaid Bills Needing Board Approval Report?  If not, stop now and 
print the report before proceeding to the next step.  For the instructions on this report 
please refer to Preparing the Treasurer’s Report covered later in this manual 
 
Entering bills in QuickBooks enables you to not only track information about your 
purchases, but also to pay these bills.  Since Claim Vouchers (Purchase Orders) have been 
created in QuickBooks you will be prompted to receive against them. 
 
To convert claim vouchers into bill, complete these steps: 
 

1. Click the Bill icon.  The Enter Bills screen will appear.  
2. Use the pull-down menu in the Vendor field to choose the first vendor to be paid. 

QuickBooks will check to see if there are any open Claim Vouchers for the vendor 
and if there are, the following message will be displayed: 
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3. In the Open POs Exist window, click Yes.  QuickBooks will then display a list of 
the Open Claim Vouchers for this Vendor.  

 

 
 

4. To choose a Claim Voucher for payment, simply use your mouse to click in the 
checkmark field next to the Claim Voucher that you wish to process for payment. A 
checkmark should appear in the column.  

5. Then click OK. QuickBooks will pull the information from the Claim Voucher into 
the Enter Bills. 

6. Verify the information on the screen.  Date and bill due date is date of upcoming 
board meeting unless it qualifies as an interim disbursement, then use date it is to 
be paid.   

7. Complete the Memo field.   
8. Enter the check number if it is available in the Reference No. field.   
9. Click Save & Close or Save & New. 

 
Reminder – Always fill in the Memo field because this is what prints on your reports. 
 
Some Claim Vouchers may keep appearing as being Open even after payment.  Complete 
the following steps to close. 

1. Go to the Reports menu and choose Purchases, and then click Open Purchase 
Orders.  This will display those Claim Vouchers that have been paid and their 
status needs to be changed to reflect “Closed.” 

2. Double click on the line to pull up the Claim Voucher. 
3. Click the blank checkbox next to Closed. 
4. Click Save & Close.   
5. The Recording Transaction window appears.  Click Yes to record. 
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 Paying Bills  
 

Okay, let’s recap our progress so far.  We have created Items (when necessary), prepared 
Claim Vouchers to be presented to the Treasurer to be reviewed/signed, and we have 
converted those Claim Vouchers to Bills. Now, we’re ready to pay the bills! 

   
To pay bills: 
 

1. Go to the Vendors menu and click Pay Bills.  The Pay Bills screen will appear. 
 

 
 
To view only the bills that are due to be approved and paid at the current month’s board 
meeting, you will click in the circle next to the Due on or before and supply the date of 
the board meeting in the Date Field. You can also choose to sort the bills to be paid in a 
variety of sequences including vendor name, due date, discount date, and amount due. To 
sort the bills according to your preference, use the pull-down menu in the Sort Bills By 
field to choose the preferred sort method.  The bills meeting the date specification will then 
appear as separate line items on the screen in the order specified. 
 

2. Select the bills that you are going to pay. 
• To pay all of the bills at one time, click on the Select All Bills button.  Only do 

this if all the bills will be paid from the same checking account and fund.  
• If you only want to pay a few of the bills and/or you need to pay bills out of two 

separate account, use your mouse to click in the checkmark column next to the 
bills to be paid out of the same account. 

3. Using the Payment Account drop-down list select the correct checking account. 
4. Complete Payment Method information.  If you are not using computer generated 

checks, you will want to choose the Assign check no. box in order to enter your 
check numbers.  
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5. Make adjustment to the Payment Date.  The check date should be the same as 
the date of the District’s board meeting. The only exception should be interim 
transactions that are authorized pursuant to KSA 12-10b & 75-4315. 

6. Click Pay Selected Bills button. 
7. Complete the Assign Check Numbers window.  If you have ordered QuickBooks 

compatible checks for your printer, you will choose the circle next to “To Be 
Printed”. On the other hand, if you are using hand-written or manually prepared 
checks, you will choose to “Assign Check No.” and enter the check numbers. 

8. Click OK. 
9. Payment Summary window appears. 

• If you need to pay more bills from a different account and/or if you have two 
bills to the same vendor and want two separate checks (otherwise QuickBooks 
combines in one check) click Pay More Bills. 

• If finished paying bills click Done. 
• If you had “To Be Printed” selected (step 7), you will also have Print Checks 

as an option. 
 
If you have two bills to the same vendor and you select them both, they will be combined 
in one check.  If you want two separate checks you will have to select them one at a time 
and then finish paying and go back and select the other bill and pay it. 
 
Always be sure you are paying this from the correct checking account.  If you need to pay 
bills out of two separate accounts (i.e., some from the Operations Fund and some from 
the Enterprise Fund) you will need to do the Pay Bills option for each account you wish 
to pay out of. 
 
You must use the Pay Bills window for your bill payments.  Do not use the Write Checks 
window to pay the bills that you entered in the Pay Bills window. 

 
 Paying Sales Tax  
 
If you have Sales Tax turned on in preferences you must process the payment different 
than what was previously discussed in Paying Bills.  Failure to do this will result in your 
balance sheet reflecting an incorrect sales tax liability. 
 
To pay sales tax: 
 

1. Go to the Vendors menu, choose Sales Tax and click Pay Sales Tax.  The Pay 
Sales Tax window appears. 

2. Select the proper checking account in the Pay From Account drop-down list. 
3. Make adjustment to the Check Date. 
4. Make adjustment to the Show sales tax due through. 
5. Enter/verify the check number in the Starting Check No. field. 
6. Use your mouse to click in the checkmark column next to the bills to be paid. 
7. If you are going to print the check, click in the To be printed checkbox. 
8. Click OK. 
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 Printing Checks  
 
If you want to order checks to be used with QuickBooks, Intuit offers multiple check styles 
in a variety of colors and designs.  It is recommended to use the Voucher Check Style.   
 
For those with QuickBooks compatible checks if you did not choose Print Checks from 
the Payment Summary window then below are the steps to print the checks. 
 
To print checks: 
 

1. Go to the File menu, choose Print Forms and click Print Checks.  The Select 
Checks to Print screen appears. 

 

 
 

2. Select the appropriate bank account from the Bank Account drop-down list. 
3. Then supply the first check number to be printed, which should match the check 

number on your preprinted check stock.  Notice that the line above the Date column 
indicates both the number of checks to be printed and the total amount of the cash 
disbursements from that account. 

4. Select the checks to print. 
•  Click beside the appropriate check(s).   
•  Click Select All if you want to print all of them and they are being paid out 

of the same account.   
5. Click OK. 
6. Choose your printer from the drop-down list. 
7. Select your Check Style (Voucher, Standard, or Wallet). 
8. Click Print. 
9. If you have written checks from both the Operations and the Enterprise accounts, 

you will need to return to the Select Checks to Print window to print checks from 
the second account.   
 

If you share a printer, notify coworkers when you have checks loaded and not to use the 
printer until you are done.   
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 Required Reports 
 
A number of customized reports have been designed specifically for conservation districts 
including the Treasurer’s Reports and Income & Expense Reports.  Many of these have 
been saved in the Memorized Reports (click on the Reports menu). 
 
The following are the reports that QuickBooks is capable of generating that meet statute 
requirements: 

 
1. Treasurer’s Report-Transaction Detail by Account is presented at each board 

meeting & a copy submitted to SCC with Minutes. 
2. Unpaid Bills Needing Board Approval is presented at each board meeting & a 

copy submitted to SCC with Minutes. 
3. Reconciliation Detail Report should be printed each month for each bank account 

after you successfully reconcile each account.  This report does not need to be 
submitted to SCC.  It is to verify accurate entries in you bank accounts. 

4. Deposit Detail report (when using the Undeposited Funds option) should be 
presented at each board meeting, however does not need to be submitted to SCC. 

 
Do not memorize each monthly report.  These are templates and you just need to change 
the dates to get the report for the given period you want. 

  
 Optional Reports 
 
There are numerous other reports available within QuickBooks that have not been 
customized and not all are discussed in this manual.  Feel free to take a look at Report 
Center (located in the Navigation bar) to view other options that you may want to use. 
 

1. The Profit and Loss by Class report (before the Treasurer’s Report-Transaction 
Detail by Account is printed) should be viewed/printed monthly to make sure 
entries have been posted to the correct account and none show up as 
“Unclassified”.  This report is found in the Reports menu-Company & Financial. 

2. QuickReports are an excellent fast source of information.  QuickReports are 
predesigned reports that give you information about the items you’re currently 
viewing onscreen.  You can right click on a name when you are in the Customer 
Center, Vendor Center, or Chart of Accounts and click QuickReport from the 
menu.    

3. Cash Balances After Bills Approved report can be created to give cash balances 
after the board approves the payment of bills (assuming all bills presented are 
approved).  Start with the “Treasurer’s Report-Transaction Detail by Account”.  
Change both the To and From dates to be the date of the board meeting (which 
should be the date of the current batch of checks).  Then click on Modify Report 
and go to the Header/Footer tab.  Change the report title to “Cash Balances After 
Bills Approved” and delete the information in the subtitle line.  Click OK.  When 
you have the report, as you want it, click on Memorize and save the report in the 
Treasurer’s Report group.  Since this is a template, you will only memorize this 
report one time (not each month). 

4. If applicable, a list of Open Invoices showing those charge customers who owe the 
conservation district.  This report is found in the Reports menu-Customers & 
Receivables. 
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 Preparing the Treasurer’s Report 
 
The Treasurer’s Report consists of two reports, the Transaction Detail by Account and 
the Unpaid Bills Needing Board Approval.  These reports are grouped together as the 
Treasurer’s Report in the Memorized Report List. 
 
Treasurer’s Report - Transaction Detail by Account 
 
  To prepare this report follow these steps: 

1. Click on the Transaction Detail by Account Report (TD by A Rpt) icon, if the icon 
has not been created then: 

a. Go to the Reports menu. 
b. Choose Memorized Reports. 
c. Choose Treasurer’s Report. 
d. Click Treasurer’s-Transaction Detail by Account. 

2. The Treasurer’s Report - Transaction Detail Account will appear on the screen 
with the Modify Report window.  (If the window isn’t open, click the Modify 
Report button in the upper, left side of the report.) 

 

 
 

3. You will need to set the From and To dates for the current reporting period.  You 
can do this by manually typing in the dates or using the calendar icons.   The report 
period may run from the first of the month to the last day of the month (prior to the 
upcoming meeting date), or the day of the last board meeting to the day before the 
upcoming board meeting. 

4. You will need to modify the report header to print the same reporting period dates 
as the From and To dates.  To change the header, click on the Header/Footer tab 
and change the date in the Subtitle field so it reflects the report period dates. 
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5. Click OK. 
6. The report appears on the screen. Click on the Print button, make any necessary 

changes in the Print Reports window. 
7. Click Print. 

 
 Voiding a Check entry off the Treasurer’s Report 

(check has been issued) 
 

We recommend not to follow the QuickBooks instructions on voiding a check, because 
your balances will change in QuickBooks as of the date the check first issued.  If a check 
has been lost or for some other reason must be voided, follow these steps: 

 
1. Make a deposit in QuickBooks for the check amount that needs to be voided to offset 

it in the system. 
2. In the description and memo indicate the check number and reason it needs to be 

voided. 
3. Enter the replacement check’s information in QuickBooks, making notations and 

cross referencing the voided check number. 
 
A special Item and account in the Chart of Accounts needs to be added and used for this 
second check in order to keep your totals correct for your year-end reports. 
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Unpaid Bills Needing Board Approval Report 
 
The information printed on this report is data from the Claim Vouchers so that is why this 
report must be printed prior to the conversion of Claim Vouchers into bills. 
 
To prepare this report, follow these steps: 
 

1. Click on the Unpaid Bills Needing Board Report (Unpd Bills Rpt) icon.  If icon 
has not been created then: 

a. Go to the Reports menu. 
b. Choose Memorized Reports. 
c. Choose Treasurer’s Report. 
d. Click Unpaid Bills Needing Board Approval. 

2. The Unpaid Bills Needing Board Approval will appear on the screen with the 
Modify Report window.  (If the window isn’t open, click the Modify Report 
button in the upper, left side of the report.) 

 

 
 

3. You will need to set the From and To dates to the day of your upcoming board 
meeting.  You can do this by manually typing in the dates or using the calendar 
icons.  Both dates should be set to the date of the upcoming board meeting.  This 
report is designed to summarize the current bills that the board will be approving 
for payment.   

4. Click OK. 
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5.  The report appears on the screen. Click on the Print button, make any necessary 
changes in the Print Reports window. 

6. Click Print. 
 
If you would like this report split out by Funds, you can do this by using the 
QuickBooks Filter option. 

1. When the report is showing on the screen, click on the Modify Report button in 
the upper, left side of the report. 

2. Click on the Filters tab across the top. 
3. Under the Filter box and click on Class. 
4. In the Class box choose the Header Account for the Fund you wish to see, i.e.  

Operations Fund or Enterprise Fund. 
5. Click OK. 
6. The report appears on the screen.  Print this report then repeat the above steps for 

the other fund. 
 
Since transferring of funds must be approved by the board, avoid using the Transfer 
Funds Feature. This will accomplish a transfer of dollars from one bank account to the 
next, but the transfers will not be reflected for approval on the Unpaid Bills Needing 
Board Approval report.  To record these transactions, write a “check” from one fund 
and code it to Account #6600 Transfers to Other Funds (expense). There is no need to 
assign a check number when you are not writing a check. If you wish, you can key 
“XFER” into the check number field to designate that transaction as a funds transfer. 
Then, make a “deposit” into the recipient fund and code it to Account #4080 Transfers 
from Other Funds (income).   
 

 Deleting an Entry on the Unpaid Bills Needing 
Board Approval Report 

 
Check has not been written: 
If you print your Unpaid Bills Needing Board Approval report and then find out that you 
need to void one of the Claim Vouchers on this report you will need to follow these steps:  
 

1. Display the Unpaid Bills Needing Board Approval report. 
2. Double-Click on the line with the bill you need to delete.  The Claim Voucher will 

appear. 
3. From the Edit menu choose Delete Purchase Order (Claim Voucher). 
4. You will be asked “Are you sure you want to delete this Transaction?”  Choose 

OK. 
 
Check has been written, but not issued: 
If you print your Unpaid Bills Needing Board Approval report and then find out that you 
need to delete (basically void) a bill on this report you will need to follow these steps:   
 

1. Display the Unpaid Bills Needing Board Approval report. 
2. Double-Click on the line with the bill you need to delete.  The Claim Voucher will 

appear. 
3. Change the amount to 0. 

4. Click Save & Close.  
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 Bank Reconciliation 
 
Reconcile all bank accounts every month in QuickBooks!  The Reconciliation Report 
should be presented and reviewed by the Treasurer every month.  You can print the report 
after reconciling. 
 
To reconcile complete the following steps: 

1. Go to the Banking menu and click Reconcile to open the Begin Reconciliation 
window. 

2. Choose the account you want to reconcile from the Account drop-down list.  
3. In the Statement Date field, enter the date of the bank statement you are trying to 

reconcile. 
4. Compare the amount in the Beginning Balance field to the opening balance amount 

shown on your statement.  (The first time the “Opening Balance” will be 0.00 and 
after that it must (or an error occurred) match the beginning balance on the bank 
statement.)   

5.  In the Ending Balance field, enter the statement ending balance.  (You must enter a 
ending balance if you only want to view you can enter 0 and then click continue. You 
can click on “Leave” at anytime without losing the work you have done in the 
reconciliation window.) 

6. Enter any service charges or interest earned that you have not already entered as 
QuickBooks transactions.  Complete all of the associated fields.   
• The date should be the date it occurred. 
• The account is the name of the expense or income account that you use to track 

these.  (Must be setup in the Chart of Accounts, “Service Charge” and “Interest 
Earned”.) 

7. Click Continue to open the Reconcile window for the account you’ve chosen. 
8. Click the transactions that match the transactions on the statement. 
9. If the Difference is 0.00 (bottom right corner of the Reconcile window), click on 

Reconcile Now.  (If the amount is not zero, click on Leave; you MUST find the error 
and correct it before completing the reconciliation.) 

10. In the Select Reconciliation Report window, select Detail and then click Print. 
11. In the Print Lists window, choose Print this report to your Printer, and then click 

Print. 
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 Deposit Detail Report 
 
This report shows details about the deposits you’ve made.  If you use the Undeposited 
Funds option in QuickBooks, you must print this report every month. 
 
To prepare this report following these steps: 
 

1. Go to the Reports menu, choose Banking, and then click Deposit Detail. 
2. The Deposit Detail will appear on the screen with the Modify Report window.  (If 

the window isn’t open, click the Modify Report button in the upper, left side of the 
report.) 

3. You will need to set the From and To dates for the current reporting period.  You 
can do this by manually typing in the dates or using the calendar icons.   The report 
period must match the report period of the Treasurer’s Report – Transaction by 
Detail. 

4. Click OK.  
5. The report appears on the screen. Click on the Print button, make any necessary 

changes in the Print Reports window. 
6. Click Print. 

 
 Adding and Removing Columns from a Report 
 
On the Deposit Detail Report you will notice that there is not a column for the Memo field.  
This is very important in order to see the detail information we need.  In order to add this 
column to the report, you will need to follow these steps: 
 

1. Display the Deposit Detail Report. 
2. Click the Modify Report button. 
3. Make sure you are on the Display tab. 
4. In the Columns box, choose Memo. 
5. Click OK in the Modify Report window. 
6. Memorize the report for reuse. 

 
To remove columns from a report, in Step 4 above- instead click on the name to remove 
the checkmark so the column will not show up on the report.  Be careful not to remove a 
column that is essential to the report in order to meet statutory requirements. 

 
 Changing the Scope of a Report (Filtering) 
 
Filters let you change the scope of a report.  When you apply a filter, you choose how you 
want QuickBooks to restrict the report.  You can apply filters either one at a time or in 
combination with each other. 
 
Let’s say you want to track the income and expense on Grass Seed.   If you set up an 
Income Account for Grass Seed and an Expense Account for Grass Seed and then two 
items, one being Grass Seed Income (posts to income account) and one being Grass Seed 
Expense (posts to expense account) you will be able to generate a Profit and Loss Report 
based on these items. 
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1. From the reports menu choose Company & Financial, Profit & Loss Standard.  
2. Click on the Modify Report button.  
3. Click on the Filters tab. 
4. In the Choose Filter box click Account. 
5. In the Account box drop-down list, scroll to the top and choose Multiple Accounts. 
6. In the list choose Grass Seed Income and Grass Seed Expense.  
7. Click OK. 
8. Click OK in the Modify Report window. 

 
Remember you can modify the dates to get the date range you are wanting.   
 
 Changing the Font  
 
You can change the font type, style and size on your reports.  For example, if you would 
like the totals to be bold on this report, you will need to follow these steps: 
 

1. With the report showing on the screen, click the Modify Report button. 
2. Click on the Fonts & Numbers tab. 
3. In the Change Font For box, choose Report Data. 
4. Click on the Change Font button. 
5. Change the Font Style to Bold. 
6. Click OK. in the Report Data window. 
7. You will be asked, “Change all related fonts?”  Choose No. 
8. Click OK. 
 
Your totals should now be Bold.  If you wish to keep these changes for each month you 
will need to memorize the report.  You can also change how numbers appear on your 
report. 

 
 Removing the Date Prepared, Time Prepared, 

and/or Report Bases from Report 
 
If your report has some information appearing at the top of your report that you do not 
wish to have displayed, you can easily remove it by following these steps: 
 

1. With the report showing on the screen, click the Modify Report button. 
2. Click on the Header/Footer tab. 
3. Select (removes checkmark) anything you do not wish to have printed on this report. 
4. Click OK. 
 
You must memorize the report to save your changes.  
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 Memorizing a Report for Reuse 
 

If you change the settings of a report and want to save the new settings, follow these steps: 
 

1. Open the report 
2. After you customize the report, click on the Memorize button at the top of the 

report. 
3. If you have changed an existing memorized report, indicate whether you want to 

replace the earlier report with the same name or create a new memorized report 
with a new name. 

4. In the Memorize Report window, enter a title for the report. 
5. If you want to save the report to a memorized report group, choose Save in 

Memorized Report Group and choose the group from the drop-down list. 
6. Click OK. 

 

 Whenever you have an icon that links back to a memorized report, anytime you make 
changes to the report these changes WILL NOT be reflected on the one associated with 
the icon. You will need to memorize the report you wish to use and delete the current 
icon and set up a new one.  
 
You do not want to memorize a bunch of the same report such as a January Treasurer’s 
Report, February Treasurer’s Report and so on.  You will just need one and then change 
the dates for the range you are wanting. 

 
 Managing Memorized Reports 
 
Moving 
To move a report from one group to another, you need to position your cursor on the 
diamond to the left of the report title.  When you get the 4 headed arrow, click and drag it 
to the location you want it to be moved. 
 
Deleting 
In order to delete a memorized report: 

1. Go to the Reports menu, choose Memorized Reports, and then click Memorized 
Report List. 

2. Select the report you want to delete. 
3. Click Memorized Report at the bottom of the list and choose Delete Memorized 

Report from the menu. 
4. Click OK. 
 

Creating New Groups 
You can customize the Memorized Report List by creating your own groupings:  

1. Go to the Reports menu, choose Memorized Reports, and then click Memorized 
Report List. 

2. Click Memorized Report at the bottom of the list and choose New Group from the 
menu. 

3. Enter a name for the memorized report group. 
4. Click OK. 
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 Customizing the Icon Bar 
 
You can add icons, delete icons, and change the appearance of the Icon bar. 
 
To add an icon for a form or a report that you use often: 
 

1. Display the form/report on the screen. 
2. Go to the View menu, choose Customize Icon Bar. 
 

 
 
3. Click Add. 
4. Choose an icon for the customized report.  QuickBooks selects one, but you can 

select a different one. 
5. Enter information in the Label and Description fields. 
6. Click OK 
 

To delete an existing icon: 
 

1. Display the form/report on the screen. 
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2. Go to the View menu, choose Customize Icon Bar. 
3. Click Delete. 
4. Click OK. 

 
 Problems with Reports 
 
There are several things that can cause your reports to not print correctly or to not show the 
correct information.  The following are answers to some common problems. 
 
Memo field is blank on my report. 
When you print reports you need to always make sure the Memo field is populated.  If you 
did not fill out the memo field on each transaction, you will have a blank on the report 
itself.  Double click that entry on the report and edit the memo field on the transaction. 
 
Why do I have an Unclassified group on my report? 
If you ever have Unclassified on a report you need to double click the entry on the report 
and edit the transaction.  You will need to add a class to the transaction. Save and Close 
the transaction and Refresh the report. 
 
Why do I have an Other group on my report? 
If you ever have a category that ends with Other, you have posted something to a header 
account instead of a sub-account.  Double click the entry on the report and edit the 
transaction.  Save and Close the transaction and Refresh the report. 
 
Report not fitting on one page. 
If you are having problems getting your report to print on one page, you can try the “Fit to 
Page” feature within QuickBooks. 

1. With the report displayed, click on the Print button to print the report. 
2. In the Print Reports Dialog box, you will see the option at the bottom of the screen 

that will allow you to place a checkmark in the Fit to ____ Pages Wide box.  Then 
you can tell it how many pages wide you would like it to be. 

3. Click Print. 
 
Report columns are not wide enough to print the information entered. 
 You may need to adjust the width of your columns in order to display more of the 
information.  In the open report move the mouse pointer to the diamond between the 
column header and drag it to make the column the width you want.  Be careful not to 
increase the width too much where it causes your report not to print correctly. 

 
 Deleting a Company 
 
If for some reason you have decided that you need to delete a company that is on your 
machine, you can do this very easily by following these steps.  Just remember, if you 
delete it, the company will be gone. 
 

1. Close any company that you have open. 
2. From the File menu choose Open Company. 
3. You will see a list of company files. 
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4. Click the file you want to delete. 
5. Click the delete key on your keyboard. 

 
 Backing Up Your Data 
 
You should save backup copies of your files to protect against accidental data loss.  You 
should backup when you close your file.  At the end of each month the entire file should be 
backed up and that file should be kept off-site.  Even though your QuickBooks files may 
be backed up by NRCS, it is best you keep your own set of backup files. 
 
To back up you data files simply: 
 

1. Click the Backup icon from the icon bar. 
2. Click Next 
3. Select the drive you wish to save to – usually a CD Drive or USB Flash drive. 
4. Click Save. 
5. When you see a window that says “Your data has been backed up successfully,” 

Click OK. 
 

As a safety protection, you could use a 5 disk rotation. You have a Monday disk, a 
Tuesday disk, a Wednesday, a Thursday disk and a Friday disk. Then you will always 
have a week of backups to use if needed. 

 
 Year-End Reports 
 
The following reports may be helpful as you prepare the year-end report: 
 

1. Income & Expenses YTD by Fund.  This report is found in the Reports menu – 
Memorized Reports – Income & Expense Reports.  The report can also be 
“collapsed” so that only “header” accounts appear.  Click on the Collapse button at 
the top of the report.  Now the report even more closely resembles the State of Cash 
Receipts and Disbursements report that is prepared annually by your auditor. 

2. Transaction Detail by Account.  This report is found in the Reports menu-
Accountant & Taxes. 

3. Sales Tax Liability.  This report is found in the Reports menu-Vendors & 
Payables. 

4. Bank Interest Earning.  Go to the Lists menu-Chart of Accounts-right click the 
Interest Income (in the 9000s) –QuickReport. 

5. Various payroll-type reports can be found in the Reports menu-Employees & 
Payroll.  You must pay the payroll subscription to use this feature. 
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 Auditor Reports 
 
Provide similar information as in past as well as additional QuickBooks reports to your 
auditor.  The following QuickBooks forms and reports will assist your auditor in addition 
to the ones you prepared at the year end.   
 

1. Claim Vouchers. 
2.  Monthly Treasurer’s Reports including Unpaid Bills Needing Board Approval 

Reports. 
3.  Income & Expenses YTD by Fund using the Cash Basis.  This report is found in 

the Reports menu-Memorized Reports-Income & Expense Reports.  To change to 
cash basis click Modify Report in the report widow, select Cash as the report 
basis, and click OK. 

4. General Ledger.  This report is found in the Reports menu-Accountant & Taxes. 
5. Balance Sheet Previous Year Comparison.  This report is found in the Reports 

menu-Company & Financial. 
6. A/R Aging Detail.  This report is found in the Reports menu-Customers & 

Receivables. 
7. Unpaid Bills Detail.  This report is found in the Reports menu-Vendors & 

Payables. 
 
Your auditor may request you create an Accountant’s Copy.  To do this, click on File 
menu-Accountant’s Copy-Client Activity-Create an Accountant’s copy. 
 
 Closing the Books 
 
You can choose whether to close your books at the “end of the year” or not.  If you decide 
to close your books do not do it until after the audit has been completed. 
 
Complete the following steps to close your books: 

1. Go to the Edit menu click Preferences. 
2. Click Accounting in the list on the left in the Preferences window. 
3. Click the Company Preferences tab at the top. 
4. Click the Set Date/Password button. 
5. Complete the information in the Set Closing Date and Password window. 
6. Click OK. 
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 Creating a Claim Vouchers from Scratch 
 
You will only use this option if you have somehow deleted the existing Claim Voucher off 
your machine or if you did not use the Standard Conservation District file to start with. 
 

1. Go to Lists menu and click Templates. 
2. Click Custom Purchase Order. 
3. From the Templates menu (lower, left side), select Duplicate. 
4. With Purchase Order selected, click OK.  
5. With the copy of the Purchase Order line highlighted, from the Templates menu, 

select Edit Template. 
6. Click on the Manage Templates button in the Basic Customization window. 
7. In the Template Name field, type in Claim Voucher. 
8. Click OK. 
9. Click the Additional Customization button (along bottom of window). 
10. Enter the information as illustrated in the screen captures below. 
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Please refer to the Sample Claim Voucher in the Appendix for the complete wording to 
enter in the Long text window. 
 

11. Click OK in the Additional Customization window. 
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 Creating a Treasurer’s Report from Scratch 
 
You will only use this option if you have somehow deleted the existing off your machine 
or if you did not use the Standard Conservation District file to start with. 
 
Treasurer’s Report – Transaction Detail by Account: 
 

1. From the Report menu choose Accountant & Taxes – General Ledger. 
2. Click on the Modify Report button. 
3. On the Display tab you will need to make sure only these columns are selected: 

Type – Date - Num – Memo – Amount – Balance. 
4. In the Dates box choose All. 
5. In the Sort By box choose Type 
6. Make sure to select Descending Order. 
7. Click the Advanced button in the lower right corner. 
8. Choose In Use and also choose Current. 
9. On the Filters tab in the Account Box choose All Bank Accounts.  
10. On the Header & Footer tab change the Report Title to Treasurer’s Report  – 

Transaction Detail by Account. 
11. For the Subtitle – Change the date, i.e. July 8 thru Aug 7, 2007. 
12. In the Extra Footer Line type – Interim trans Auth. Pursuant to KSA 12-105b & 

KSA 75-4315. 
13. Click OK. 
14. Then Click the Memorize button and memorize the report.  Go ahead and group in 

the Treasurer’s Report Group. 
 
Unpaid Bills Needing Board Approval Report: 
 

1. From the Report menu choose Purchases – Open Purchase Orders. 
2. Click on the Modified Report button. 
3. On the Display Tab you will need to make sure only these columns are selected: 

Type – Num – Memo – Class – Amount. 
4. In the Dates box choose Today. 
5. In the Sort By box choose Class. 
6. Make sure to select Descending Order. 
7. Click the Advanced button in the lower right corner.   
8. Choose In Use and also choose Current. 
9. On the Filters tab everything should be the same. 
10. On the Header & Footers tab change the Report Title to Unpaid Bills Needing 

Board Approval. 
11. Click OK. 
12. Then Click the Memorize button and memorize the report. Go ahead and group it in 

the Treasurer’s Report Group. 
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 Summary of Steps in Preparing Board Meeting 
Financial Reports 

 
The following are the basic QuickBooks steps to perform in preparation for an upcoming 
conservation district board meeting.  (These steps do not include optional reports or 
interim disbursements.) 
 
Enter Sales & Deposits throughout the month. 

Basic Options: 
A. Cash Customers (pay in full when receive product or service).  

1. Enter Sales Receipt. 
2. Print (2) Sales Receipts. 
3. Make Deposits. 

B. Charge Customers (don’t pay in full when receive product or service or when 
pay in advance) 

1. Create Invoice. 
2. Print Invoices. 
3. Receive Payments. 
4. Make Deposit. 

C. Cash Customer and Bank Interests using a receipt book outside of QuickBooks. 
1. Complete Receipt (hard copy). 
2. Make Deposit. 

     
Enter Claim Vouchers and Print. You must print unpaid bills before converting 
claim vouchers to bills. 
 
Print Treasurer’s Reports: 

o Treasurer’s Report – Transaction Detail By Account.  (Normally dated day of last 
board meeting to the day before upcoming meeting.) 

o Unpaid Bills Needing Board Approval.  (Should be dated the day of upcoming 
board meeting.)  Look this over carefully making sure it is correct before 
completing next step.  

 
Convert Claim Vouchers into Bills.  (Use the Unpaid Bills needing Board Approval 
report as reference.) 
 
Pay Bills.  (Use the Unpaid Bills needing Board Approval report as reference.)  Do not use 
the Write Checks window to pay a bill. 
 
Print Checks (if have computer generated checks). 
 
 
What needs stent to the State Office? 

1. Treasure’s Report 
2. Unpaid Bills Report 
3. Minutes 
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 Sample Chart of Accounts 
 
 
 
Account                                                      Type 
 
1000 Checking #1 [Name of Bank]  Bank   
 1001 Operations Fund Checking  Bank 
 1002 Enterprise Fund Checking Bank 
1005 Checking #2 [Name of Bank] Bank                           
 1006  Operations Fund Checking Bank 
  1006.1  Operations Bank 
  1006.2  Non-Point Source Bank 
  1006.3  Grants Bank 
 1007 Enterprise Fund Checking Bank 
  1007.1  Enterprise Bank 
  1007.2 Farm Account Bank 
1010  Checking #3 [Name] Operations Fund Bank 
1015  Checking #3 [Name] Enterprise Fund Bank 
1050  Savings Account #1 [Name of Bank] Bank 
 1051 Operations Fund  Bank 
 1052 Enterprise Fund  Bank 
1055 Savings [Name] #2 ___________ Fund Bank 
1060 Savings [Name] #2 ___________ Fund Bank 
1090 Petty Cash – Operations Bank 
1095 Petty Cash – Enterprise Bank 
1200 Accounts Receivable Accounts Receivable 
1120 Inventory Asset Other Current Asset 
2000 Accounts Payable Accounts Payable 
2100 Payroll Liabilities Other Current Liability 
 2105 Federal Withholding Other Current Liability 
 2110  FICA/Medicare Other Current Liability 
 2115 State Withholding Other Current Liability 
 2120 Federal Unemployment Other Current Liability 
 2125 State Unemployment Other Current Liability 
 2130 Deferred Comp. Plan  Other Current Liability 
 2140 KPERS Other Current Liability 
 2145 Health Insurance Payable Other Current Liability 
2200 Sales Tax Payable Other Current Liability 
3000 Opening Balance Equity Equity 
3900 Retained Earnings Equity 
4005 Appropriations – State Income 
4010 Appropriations – County Income 
4015 Retail Sales and Services Income 
 4016 Grass Seed Income Income 
 4017 Marking Flags Income Income 
 4018 Trees Income Income 
 4019 Weed Barrier Fabric Income 
 4020 Pipe  Income 
Account                                                      Type 
  

For one checking acct. with both 
Operations & Enterprise Funds 
 

For one checking account with 
both Operations & Enterprise 
Funds and subaccounts of each 
 

For two checking accts., one for 
Operations & one for Enterprise 

For one savings/CD acct. with both 
Operations & Enterprise Funds 

For two savings/CD acct. with 
Operations and/or Enterprise Funds 

Use only 
with 
QuickBooks 
Payroll 
Service 
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  4021 Tree Planting Income 
 4022 Deer Repellent Income 
 4023 Protective Tree Netting Income 
 4024 Root Slurry Income 
 4026 Drip Irrigation Supplies Income 
 4027 Custom Drilling Income 
4050 Equipment Rental Income 
 4051 Grass Drill Rental Income 
 4052 No-Till Drill Rental Income 
 4053 Scraper Rental Income 
 4054 Miscellaneous Equipment Rental Income 
 4055 Burn Equipment Rental Income 
4060 Building Rent  Income 
4065 Newsletter Advertising Income 
4075 Miscellaneous  Income 
4080 Transfers from Other Funds Income 
4085 Commissions  Income 
4090 Non-Point Source Revenue Income 
 4091 TA  Income 
 4092 Information & Education Income 
5000 *Cost of Goods Sold Cost of Goods Sold 
6000 Cost of Goods Sold Cost of Goods Sold 
 6001 Marking Flags Expense Cost of Goods Sold 
 6002 Grass Seed Expense Cost of Goods Sold 
 6003 Livestock Tanks Expense Cost of Goods Sold 
 6004 Trees Expense Cost of Goods Sold 
 6005 Other Goods Expense Cost of Goods Sold 
6050 Salaries and Wages Expense 
 6051 Wages  Expense 
 6052 Payroll Taxes Expense 
 6053 KPERS, Employee Portion              Expense  
6060  Employee Benefits Expense 
 6061 Workers Compensation Insurance Expense 
 6062 401(k) Contributions Expense 
 6063 Medical Insurance Premiums Expense 
 6064 Life Insurance Premiums Expense 
 6065 SS & Medicare Expense 
 6066 KPERS, Employer Portion Expense 
6069 Business Related Expenses Expense 
 6070 Supervisor Expense 
  6071 Mileage Expense 
  6072 Meals Expense 
  6073 Lodging Expense 
  6074 Registration Fees Expense 
 6080 Employee Expense 
  6081 Mileage Expense 
  6082 Meals Expense 
  6083 Lodging Expense 
  6084 Registration Fees Expense 
Account                                                      Type 
 

Use only use if 
tracking inventory 

Use if not tracking 
inventory in 
QuickBooks 
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 6090 Associate Supervisor/Advisor Expense 
  6091 Mileage Expense 
  6092 Meals Expense 
  6093 Lodging Expense 
  6094 Registration Fees Expense 
6100 Information and Education Expense 
 6101 Newsletter, Brochure, Pamphlet Expense 
  6102 Postage and Delivery Expense 
  6103 Printing and Reproduction Expense 
  6104 Supplies Expense 
 6105 Advertising Expense 
 6110 Education Expense 
  6111 Tour/Field Days Expense 
  6112 Booklets, Games, Etc. Expense 
  6113 Donations Expense 
  6114 Prizes Expense 
  6115 Scholarships Expense 
  6116 Supplies Expense 
  6117 Educational Tools Expense 
 6120 Programs and Projects Expense 
 6125 Sponsorships Expense 
 6130 Promotional Activities Expense 
6200 Other Administrative Expense 
 6201 Office  Expense 
  6202 Computer Software Expense 
  6203 Fidelity Bond Expense 
  6204 Licenses and Permits Expense 
  6205 Postage and Delivery Expense 
  6206 Printing and Reproduction Expense 
  6207 Professional Fees Expense 
   6208 Accounting Expense 
   6209 Legal Fees Expense 
  6210 Subscriptions Expense 
  6211 Supplies Expense 
   6212 Marketing Expense 
   6213 Office Expense 
  6214 Telephone Expense 
  6215 Bank Service Charge Expense 
  6216 Depreciation Expense Expense 
  6217 Freight  Expense 
  6218 Expense Reimbursements Expense 
  6219 Storage Expense 
  6220 Utilities Expense 
   6221 Gas and Electric Expense 
   6222 Water Expense 
  6224 Cash Discounts Expense 
  6225 Contributions Expense 
 6230 Annual Meeting Expense 
  6231 Door Prizes Expense 
Account                                                      Type 
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  6232 Advertisement Expense 
  6233 Building or Room Rent Expense 
  6234 Decorations Expense 
  6235 Entertainment Expense 
  6236 Janitorial Expense 
  6237 Legal Notice Expense 
  6238 Meals  Expense 
  6239 Supplies Expense 
 6250  Dues and Fees  Expense 
  6251 Association Dues Expense 
  6252 Filing Fees Expense 
  6253 Franchise Fees Expense 
  6270 Rentals Expense 
  6271 Equipment Rental Expense 
  6272 Building Rental Expense 
  6273 Vehicle Rental Expense 
 6280 Insurance  Expense 
  6281 Disability Insurance Expense 
  6282 Liability Insurance Expense 
 6290 Interest  Expense 
  6291 Finance Charge Expense 
  6292 Loan Interest Expense 
  6293 Mortgage Interest Expense 
6300 Equipment and Building Expense 
 6301 Repairs  Expense 
  6302 Building Repairs Expense 
  6303 Computer Repairs Expense 
  6304 Equipment Repairs Expense 
 6310 Small Equipment Purchases Expense 
 6315 Automobile Expense Expense 
 6320 Equipment Expense Expense 
6400 Miscellaneous Expense  Expense 
6500 Taxes     Expense 
 6501 Federal Taxes  Expense 
 6502 Local Taxes  Expense 
 6503 Property Taxes Expense 
 6504 State Taxes  Expense 
6600 Transfers to Other Funds Expense 
9000 Interest Income   Other Income 
 9001 Checking Account Other Income 
 9002 Savings Account Other Income 
 9003 Certificate of Deposit Other Income 
 9004 Other Investments Other Income 
9010 Donations   Other Income 
9020 Other Income   Other Income 
9050 Other Expenses   Other Expense 
Bills to Be Coded   Other Expense 
2 . Purchase Orders   Non-Posting 

These are not 
Payroll or Sales Tax 
Accounts 
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Sample Sales Receipt 
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 Sample Claim Voucher 
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 Sample Treasurer’s Report – Transaction Detail 
by Account 

 
[Last board meeting was Aug. 8 and upcoming meeting is Sept 7, 2015] 
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 Sample Unpaid Bills Needing Board Approval 
Report 

 
[Board meeting is Sept 7, 2015.] 
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